Carlson Explorer User Guide

Carlson Software Inc.

User’s manual

September 26, 2006
## Contents

Chapter 1. **Basic Information** .................................................. 1
  - Your Carlson Explorer ................................................................ 2
  - Attention: Read This First! .................................................... 2
  - Legal and Trademark Information ........................................ 3
  - Changes and Addendum ....................................................... 3
  - Contact Information .......................................................... 3
  - What is in the Box? .......................................................... 4
  - Warranty Information ....................................................... 4
  - Product Returns ................................................................... 5
  - Regulatory Notices .......................................................... 5
  - Certifications ..................................................................... 5
  - Warnings ........................................................................... 6

Chapter 2. **Overview** .......................................................... 8
  - About Carlson Software ....................................................... 9
  - About the Carlson Explorer .............................................. 9
  - Carlson Explorer Features .................................................. 9

Chapter 3. **Carlson Explorer Components** .............................. 12
  - Front Components and Indicators ....................................... 13
  - Top of Unit: Compact Flash Slot Cover ............................... 14
  - Bottom Connections ....................................................... 15
  - Connecting Via the Serial Port .......................................... 17
  - Accessories & Options ...................................................... 18

Chapter 4. **Operation** .......................................................... 19
  - Power ................................................................................ 20
  - Data Entry .......................................................................... 24
  - Rebooting the Carlson Explorer ........................................... 28
  - Operating System ........................................................... 28
  - Windows CE.net Desktop ................................................... 29
  - Hot Keys ........................................................................ 32
Basic Information
Your Carlson Explorer

This is a technical reference for the Carlson Explorer, Carlson Explorer II and the Carlson Explorer 600+ data collector.

Attention: Read This First!

PLEASE READ THE INSTRUCTIONS BELOW BEFORE OPERATING YOUR UNIT

Are You Registered? Be sure your product is properly registered. It is possible that your dealer did not transfer the registration from his company to yours. To register, visit our web site at www.carlsonsw.com, select the Support tab, select Product Registration and then Carlson SurvCE registration.

If you encounter problems there are instructions in our website Knowledge Base, under Support, or you may fill out the information on the back of this form and fax to Carlson Software. Our fax number is 606-564-6422.

As you get started, make special note of these three key items:

1. CAUTION! Do Not Remove the Battery to Reboot

To reboot, hold the On/Off key down for 10 seconds.

2. IMPORTANT! Regarding Job Storage on the Carlson Explorer

All job files must be stored to the internal CF card ("hard drive") named system CF. In the event of a power loss or necessary hard reboot, this card will preserve these files. Job files stored in all other on-board locations, including the desktop, are vulnerable to deletion in the event of a power loss. The external CF card is not affected.
by this issue and data may also be safely stored on it.

3. The Screen

To increase the life of your screen, you should use screen protectors. Also, you should not use sharp objects with the touch screen.

Legal and Trademark Information


Date of last revision: September 22, 2006
©2006, Carlson Software
All rights reserved.

Copyrights and Trademarks

The Carlson Software logo is a registered trademark of Carlson Software.
The 2T logo and JETT are registered trademarks of Two Technologies.
Other products or company names mentioned herein may be the trademarks or registered trademarks of their respective companies.

Reproduction Rights

This manual contains proprietary information. Permission to reproduce or otherwise use portions of the material presented herein is explicitly not permitted.

Changes and Addendum

Since Carlson Software is continuously improving the functionality and quality of its products, certain information may not be included in this manual at its time of release. As a result, Carlson Software may provide changed material as separate sheets included with this manual, or separately in the form of a change package, as it deems necessary.

Contact Information

Carlson Software
102 West 2nd St
Maysville, KY 41056
Phone: 606-564-5028
Fax: 606-564-6422
What is in the Box?

In this box you will find:

- Carlson Explorer unit
- Quick Start Guides
- Carlson Explorer Manual
- Charger (North American, European, United Kingdom, Australia or Rest of the World model)
- 9-pin null modem cable
- Carlson SurvCE manual

Warranty Information

Seller warrants that the product specified in this agreement is free of defects in materials and workmanship, and shall conform to the latest specifications published prior to Buyer's acceptance of the agreement for a period of two years.

Product specifications as defined supersede previous specifications and are complete. Any parameter that is not specifically defined in the specifications is expressly excluded from the warranty. This warranty does not apply to any product which has been subject to misuse, accident, alteration, or if the unit has been serviced by anyone other than an authorized representative of Seller.

Seller's sole obligation to Buyer for products failing to meet specifications shall be, at Sellers' discretion, to repair or replace the non-conforming device.

After receiving a Return Material Authorization (RMA) number and a mailing address from Seller, a defective unit covered under this warranty may be returned freight prepaid. Any replacement or repaired product shall carry only the unexpired term of the warranty plus any period required for repair.

THE FOREGOING WARRANTY AND REMEDIES ARE EXCLUSIVE AND ARE MADE EXPRESSLY IN LIEU OF ALL OTHER WARRANTIES EXPRESSED OR IMPLIED, EITHER IN FACT OR BY OPERATION OF LAW, STATUTORY OR OTHERWISE, INCLUDING WARRANTIES OF MERCHANTABILITY AND FITNESS FOR USE. CARLSON SOFTWARE NEITHER ASSUMES NOR AUTHORIZES ANY OTHER PERSON TO ASSUME FOR IT ANY OTHER LIABILITY IN CONNECTION WITH THE SALE, INSTALLATION OR USE OF ITS PRODUCTS AND CARLSON SOFTWARE MAKES NO WARRANTY WHATSOEVER FOR PRODUCTS NOT SOLD BY CARLSON SOFTWARE.

CARLSON SOFTWARE SHALL NOT BE LIABLE FOR DAMAGES DUE TO DELAYS IN DELIVERIES OR USE AND SHALL IN NO EVENT BE LIABLE FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES OF ANY KIND, WHETHER ARISING FROM CONTRACT, TORT OR NEGLIGENCE, INCLUDING, BUT NOT LIMITED TO, LOSS OF PROFITS, LOSS OF GOODWILL, OVERHEAD OR OTHER LIKE DAMAGES.

To maintain your warranty and to avoid creating hazards, only qualified personnel should perform authorized modifications to CARLSON SOFTWARE products. CARLSON SOFTWARE cannot assume responsibility for any
condition affecting the proper operation of this equipment that may result from unauthorized modifications.

**Product Returns**

If, after inspection, you note any product damage or discrepancies, please contact us promptly within five days of receipt. If the exterior of the package shows obvious signs of damage, please contact your carrier directly.

All items returned to Carlson Software require a Return Material Authorization number (RMA).

**Carlson Explorer RMA Procedure**

To request a Return Merchandise Authorization number to return a Carlson Explorer for repair:

1. Contact Carlson Software at RMA@carlsonsw.com or 606-564-5028.

2. We must have the Serial Number of the hardware. It is on the back of the unit and starts with HH.

3. We must have a full and detailed description of the problem.

4. We must have the complete address, telephone number and contact name of the shipping party. (The unit will be returned to this address.)

**Regulatory Notices**

**FCC Compliance**

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

**Canadian Department of Communications**

This digital apparatus does not exceed the Class A limits for radio noise emissions from digital apparatus set out in the Radio Interference Regulations of the Canadian Department of Communications.

Le présent appareil numérique n'émet pas de bruits radioélectrique dépassant les limites applicables aux appareils numeriques de la class A prescrites dans le Reglement sur le brouillage radioélectrique edite par le ministere des Communications du Canada.

**Certifications**

CENELEC
MI Standards:

- EN55022:1998 (CISPR22), Class A
- EN55022/IEC 61000-4-6

EMC Standards:

- EN55024: 1998
- ETSI EN 301489-1, 2002
- ETSI EN 301489-3, 2002
- EN/IEC 61000-4-2
- EN/IEC 61000-4-3
- EN/IEC 61000-4-4

Safety Standards:

- EN60950:2000

Warnings

Changes or modifications to this unit not expressly approved by the party responsible for regulatory compliance could void the user's authority to operate the equipment.

Electrostatic Discharge (ESD)

Electrostatic discharge (static electricity) can have unpredictable adverse effects on any electronic device. Although the design of this product incorporates extensive ESD-related precautions, ESD can still cause problems. It is good practice to discharge static by touching a grounded metal object before inserting cards or connecting devices.

Battery Replacement (ESD)
CAUTION! There is a risk of explosion if you replace the NiMH battery with an incorrect type. Only use the NiMH battery supplied with your unit or a replacement NiMH battery supplied, recommended, or approved by Carlson Software, Inc.

Battery Disposal

Dispose of batteries in a safe manner. The following are general guidelines for the safe use and disposal of NiMH batteries:

- Replace a defective NiMH battery immediately, as it could damage the unit.

- Do not throw the NiMH battery in trash that is disposed of in landfills, as it contains heavy metals. Recycle or dispose the NiMH battery as required by local ordinances or regulations.

- Do not disassemble, incinerate, short-circuit the NiMH battery or throw it into a fire. It can explode and cause severe personal injury.

- Excessive discharge damages a NiMH battery. Recharge the NiMH battery when your unit indicates low battery power.
Overview
About Carlson Software

Founded in 1983, Carlson Software, Inc. is a leading provider of office and field software for land development markets, including land surveying, civil engineering, mining, construction, accident reconstruction and machine control.

Carlson Software is headquartered in Maysville, KY, with offices in Atlanta and Boston.

About the Carlson Explorer

With its modern, ergonomic appearance and design, this rugged Carlson Explorer hand-held unit combines state-of-the-art hardware, powered with Carlson SurvCE, for the most powerful and easy to use data collection package available today.

Your unit uses the very latest, environmentally-rated hardware case. It is a weather-resistant ruggedized shell that is rated to withstand wind-driven rain. To give you even better control, this product has a non-glare keyboard, optimized for surveyors.

If you have the Explorer 600+, your unit comes standard with WiFi and Bluetooth, USB port, Serial port and a CF slot.

The Carlson Explorer also features a powerful Windows CE .NET operating system and the Intel XScale processor. It supports a wide variety of removable peripheral devices, such as wireless LANs, modems, bar code readers, cameras and Bluetooth.

Carlson Explorer is powered with Carlson SurvCE – the innovative Windows CE data collection software for land surveying professionals. Carlson SurvCE is a complete data collection system for Real Time (RTK) GPS and Total Stations with in-field coordinate geometry.

Carlson Explorer Features

Rechargeable Battery Pack

The Carlson Explorer comes with a rechargeable Nickel Metal Hydride (NiMH) battery pack that can provide up to twelve hours of operating time on a full charge (depending on power management and use).
The NiMH technology used in the Carlson Explorer has exceptional charge life without the "charge memory" characteristic of conventional nickel cadmium batteries. Partially discharged batteries or extended periods with the charger left connected will not adversely affect battery life or performance. The Carlson Explorer can also run on six AA Alkaline batteries.

Operating System

The Carlson Explorer uses Windows CE .NET Professional 4.2 as its operating system.

Processor, Memory, Mass Storage

See individual unit specifications for details about processor, processor speed and architecture. The Carlson Explorer comes standard with 64MB of SDRAM and 128MB (approximately 16MB used for operating system)
of internal compact flash memory. The Carlson Explorer II comes standard with 64MB of SDRAM and 256MB (approximately 16MB used for operating system) of internal compact flash memory. The Carlson Explorer 600+ comes standard with 128MB of SDRAM and 256MB (approximately 16MB used for operating system) of internal compact flash memory. These Carlson Explorer models are equipped with a Compact Flash (CF) slot.

**Displays and Keypads**

The Carlson Explorer features a supertwist nematic liquid crystal 320 x 240 QVGA-TFT color sunlight readable display with a touch screen and LED backlight. Standard keypad configurations for the Carlson Explorer and Explorer II include 45-key elastomeric keypad. The Carlson Explorer 600+ includes a 53-keys elastomeric with toggle key. See individual specifications in the Hardware Specifications section of this manual.

**Indicators**

The Carlson Explorer series have six LED indicators, including an LED indicating charge and low battery statuses.

**Interface Capabilities**

Depending upon your model, there are several configurations possible. Please see the Hardware Specifications in this manual for details on your model.

**Durability**

The case is made of General Electric Xenoy, one of the most durable chemical resistant materials available today.
Carlson Explorer
Components
Front Components and Indicators

The Carlson Explorer is a customized version of a product manufactured by Two Technologies, Inc.. The diagrams below are for reference purposes only, and may not be exactly the same on the Carlson Explorer. This section describes the components and indicators found on the front of the Carlson Explorer, and the physical dimensions.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Display</td>
</tr>
<tr>
<td>2</td>
<td>Battery Indicator</td>
</tr>
<tr>
<td>3</td>
<td>LEDs</td>
</tr>
<tr>
<td>4</td>
<td>On/Off Switch</td>
</tr>
<tr>
<td>5</td>
<td>Keypad</td>
</tr>
</tbody>
</table>

Front Components and Front Indicators
Case Dimensions: Indicators and Physical Dimensions

Note: Specifications subject to change.

**Top of Unit: Compact Flash Slot Cover**

**Top of Unit**

The standard compact flash slot cover, located on the top of the unit, provides access to the compact flash slot that stores memory and device cards.
Sealed Compact Flash Slot Cover

The sealed cover has a set of tamper-proof 1-32 x 1/4" long Torx or Phillips screws (depending upon the model) to restrict access to the compact flash slot. This sealed cover also provides additional protection against the elements. To remove the Torx screws, an IP6 Torx (T6) driver is required, and it can be purchased at any automotive supply house.

**Bottom Connections**

**Interface Connections at Bottom of Unit**

**Carlson Explorer and Carlson Explorer II:** The DE-9 connectors emulate standard serial pin-out connections, and allow you to connect the Carlson Explorer to most desktop PCs using a standard null modem cable.
Carlson Explorer 600+: This section describes the interface connectors found on the bottom of the Carlson Explorer 600+.

### RS-232 Interface Pin-Outs

| Pin 1 = DCD | Pin 6 = DSR |
| Pin 2 = RXD | Pin 7 = RTS |
| Pin 3 = TXD | Pin 8 = CTS |
| Pin 4 = DTR | Pin 9 = 11-18VDC Input |
| Pin 5 = Ground |

DE-9 Male Interface Connector

### USB Pin-Outs

| Pin 1 = VBUS |
| Pin 2 = D- |
| Pin 3 = D+ |
| Pin 4 = ID |
| Pin 5 & Drain = Ground |
### Power Jack

The power jack found on the bottom of the Carlson Explorer and Carlson Explorer II enables you to connect an 11-18 VDC Input power supply battery charger, such as Carlson Software Part # 1490. Use of other power supplies may cause damage to the unit and void the warranty. The Carlson Explorer 600+ charges through the DE-9 connector.

![Power Jack Diagram]

**Power Jack for the Carlson Explorer and Carlson Explorer II**

Note: The Carlson Explorer 600+ charges through the DE-9 connector.

### Connecting Via the Serial Port

Use the 9-pin null modem cable, included with your Carlson Explorer, to connect the COM1 port of your Carlson Explorer to the serial port of your PC.
Accessories & Options

Carlson Software can provide the following optional accessories, which include power supplies, cable and adapters, based on communication and power requirements.

Part List (All Units)

Here is a list of the available accessories for the Carlson Explorer, Explorer II and Explorer 600+:

<table>
<thead>
<tr>
<th>Part List - Carlson Explorer Radio Components (Carlson Explorer 600+ Only)</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>6100.001</td>
<td>Carlson Explorer Battery Pack 1500Mah</td>
</tr>
<tr>
<td>6100.002</td>
<td>Carlson Explorer Vehicle Charger</td>
</tr>
<tr>
<td>6100.003</td>
<td>Carlson Explorer Carrying Bag</td>
</tr>
<tr>
<td>6100.004</td>
<td>Carlson Explorer Data Max Bracket/Clamp system</td>
</tr>
<tr>
<td>6100.005</td>
<td>Carlson Explorer Environmental Case w/ strap</td>
</tr>
<tr>
<td>6100.007</td>
<td>Carlson Explorer null modem cable</td>
</tr>
<tr>
<td>6100.008</td>
<td>Explorer 600+ Charging Kit - Includes Charger and Charging Cable</td>
</tr>
<tr>
<td>6100.010</td>
<td>Carlson Explorer Screen Protectors (5 units)</td>
</tr>
<tr>
<td>6100.013</td>
<td>Styl - Package of 3 Black</td>
</tr>
<tr>
<td>6100.014</td>
<td>Carlson Explorer Wall Charger</td>
</tr>
<tr>
<td>6100.016</td>
<td>Australian Adapter</td>
</tr>
<tr>
<td>6100.017</td>
<td>Europe Adapter</td>
</tr>
<tr>
<td>6100.018</td>
<td>International Power Supply</td>
</tr>
<tr>
<td>6100.019</td>
<td>Carlson Fuel - Charges Four Batteries</td>
</tr>
<tr>
<td>6100.020</td>
<td>Carlson Fuel - Charges One Battery</td>
</tr>
<tr>
<td>6100.021</td>
<td>Rest of the World Adapter</td>
</tr>
<tr>
<td>6100.022</td>
<td>UK Adapter</td>
</tr>
<tr>
<td>6100.023</td>
<td>Explore 600+ Charging Cable</td>
</tr>
<tr>
<td>6100.024</td>
<td>USB Type A to Mini B</td>
</tr>
<tr>
<td>6100.430</td>
<td>SS900 Radio Carrying Case</td>
</tr>
<tr>
<td>6100.433</td>
<td>Carlson Explorer Battery Pack 2500Mah</td>
</tr>
<tr>
<td>6100.435</td>
<td>Styl - Package of 3 Orange</td>
</tr>
</tbody>
</table>

The Carlson SS900 Radios work with the Carlson Explorer 600+ only, and they are not available for any other model.

<table>
<thead>
<tr>
<th>Part List - Carlson Explorer Radio Components (Carlson Explorer 600+ Only)</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>6100.499</td>
<td>Carlson SS900 Base / Repeater Radio</td>
</tr>
<tr>
<td>6100.500</td>
<td>Carlson SS900 Rover Package</td>
</tr>
</tbody>
</table>

The 6100.500 SS900 Rover Package includes the Explorer Pack Connect, SS900 Rover Radio, a 2500Mah battery, a Carlson Fuel Charger for one battery, a SS900 rover Package Carrying Case and Installation. The Explorer 600+ must be returned to Carlson Software for installation of the SS900 Rover Package.
Power

The Carlson Explorer comes with a rechargeable Nickel Metal Hydride (NiMH) battery pack that can provide up to twelve hours of operating time on a full charge, depending on power management and use. This battery is fully charged and installed in the unit when shipped. However, because some battery dissipation occurs between the time when the unit ships and when you start using it, you should charge the unit for approximately four hours before using it without the battery charger/power supply connected.

Charging the Unit

The nickel metal hydride battery technology used in the Carlson Explorer has exceptional charge life without the "charge memory" characteristic of conventional nickel cadmium batteries. Partially discharged batteries, or extended periods with the charger left connected, will not adversely affect battery life or performance.

CAUTION! Because the internal battery charger senses several conditions, including temperature, you should charge the unit away from any known or potential heat sources. Units exposed to temperatures in excess of 110 degrees Fahrenheit during the charge cycle may experience incomplete charging and reduced operating time per charge.

1. Plug your power jack into the power jack receptacle on the bottom of your Carlson Explorer and Explorer II. If you have the Explorer 600+, plug the interface cable into the connector on the bottom of that unit.

2. Plug the battery charger/power supply into a power outlet. The Charge (CHG) LED should turn on, indicating that the batteries are charging (see table below).
3. Once the battery is fully charged (approximately four hours), you can disconnect the AC power supply and run the Carlson Explorer exclusively on battery power.

**Power On**

To power on the Carlson Explorer:

4. Press and hold the ON/OFF switch for one second.

5. The unit should turn on and begin displaying the boot-up process. For example:

```
***** Carlson Explorer *****
Loader Ver x.x.x
Booting from System Socket
Loading CE image...

```

Where x.x.x is the version number

6. After approximately 20-25 seconds, the Windows CE.net desktop should appear.
Windows CE.net desktop

However, because there is no outward indication (such as a flashing LED) that the Carlson Explorer is powered off or in Suspend mode, the Carlson Explorer may resume an active application if it is indeed in a suspended state.

If the unit does not power up, or you cannot select any items from the desktop, refer to the "Error! Reference source not found" chapter for help.

**Charge/Low Battery Indicator**

When using the NiMH battery pack, the CHARGE/LOW BAT LED will indicate the current battery status as shown in the table below.
The On/Off switch is located above the keypad. Its function depends on the state of the Carlson Explorer at the time the switch is pressed, and on the length of time that the switch is depressed. Operations that the Power switch can initiate are Power On, Power Off and Suspend.

**Power/Suspend Switch**

To turn off the Carlson Explorer, press and hold the ON/Off switch for approximately eight seconds. This action will also terminate any running applications, and cease serial port operations.

**Suspend Mode**

Suspend mode allows you to suspend, but not terminate, active applications. In this mode, the display will turn off and the Carlson Explorer will cease serial port operations. For battery-powered units, use of the Suspend mode also conserves battery power.

To place the unit in Suspend mode, press and release the On/Off switch.

To take the Carlson Explorer out of Suspend mode, either touch the screen or press and release any key. The display will turn on, and the Carlson Explorer will resume running any suspended application, but you must restart any serial port operations.
If you attempt to resume immediately after suspending the Carlson Explorer or vice versa, the unit will automatically delay three seconds before resuming or suspending.

### Power Management

Battery-powered units can utilize a rechargeable Nickel Metal Hydride (NiMH) battery pack that has an average operating time between ten and twelve hours on a full charge with power management, and approximately eight hours without power management. As with all battery-powered devices, the operating time is completely dependent on the environment, device usage and the number and type of power-drawing peripherals attached. The battery discharge rate in a full "Power Off" state is only slightly higher than the self-discharge rate of the battery itself.

**CAUTION!** Allowing the batteries to remain in a low or very low condition will cause the unit to enter Suspend mode. In either case, you should save your work and recharge the unit as soon as possible.

To lengthen the time between charges, you can perform the following actions:

#### Use external PC Cards

Some PC cards, as well as extended communication via the serial port, may require additional power to operate, and can drain the batteries at an accelerated rate.

#### Limit the use of backlight

Minimize backlight use when you are operating on battery power. You can adjust the backlight timeout level through the Display Settings in the Control Panel, or on some units by using the keypad.

![Display Properties](image)

The Carlson Explorer is automatically set to suspend operation to conserve battery power when you have not used the keyboard or the stylus after three minutes. You can increase the Auto-suspend time by changing the Power settings in the Control Panel.

### Data Entry

#### 45-Key Keypad
The Carlson Explorer and Carlson Explorer II units come with a 45-key keypad.

45-key Keypad

53-Key Keypad

The Carlson Explorer 600+ units come with a 53-key keypad.
Modifier Keys

In order to provide the functionality of a full-sized keyboard with only 45 or 53 keys, the Carlson Explorer, Explorer II and Explorer 600+ keypads must depart from PC-style key assignment conventions by making use of multifunctional modifier keys. Units configured with the standard 45-key or 53-key keypad typically utilize five LED indicators (located above and to the left and right of the ON/OFF switch) to indicate the active state of keypad modifier keys.

Modifier keys take effect when first pressed, and typically remain in effect until you press another key, unless its another Modifier key. Optionally, equipped units can use LEDs to indicate the selection of a Modifier key.

CTRL and ALT Keys: These operate in the same manner as on conventional PCs, except that by default they have a one-time locking action to facilitate one-handed operation.

1ST and SHIFT Key: Unlike conventional PC keyboards, on the Carlson Explorer and Carlson Explorer II, the 1ST and SHIFT keys enables you to access symbols, punctuation marks and navigation arrows rather than shift alphabetic keys to uppercase. The 1ST and SHIFT keys have a one-time locking action to facilitate one-handed
operation. On the Explorer keypads, the functions and characters accessed via the 1ST key appear in the upper left of a key, shaded in a color that matches the modifier key. However, the SHIFT key on the Carlson Explorer 600+ toggles whether or not you are operating with upper or lower case lettering.

2ND Key: This key shifts the numeric keys to corresponding function keys (1 = F1, 2 = F2, etc.) that are found on conventional PC keyboards. It also shifts other keys for punctuation, non-printing characters (such as Delete and TAB), and PC key definitions (such as PageUp, PageDown, Home, Insert and Caps Lock). Like other modifier keys, the 2nd key has a one-time locking action to facilitate one-handed operation. On the keypads of the three Explorer units mentioned in this section, the functions and characters accessed via the 2ND key appear at the bottom of a key, shaded in blue.

Units with any of these keypads layouts also have keypad functions to adjust the contrast and backlight.

CE Keyboard

In addition to entering data through the keypad, you can also enter data by using the CE Keyboard. This utility displays a keyboard on the screen to allow data entry via the Command Line, or into applications where "text accessibility" control has focus (i.e., text or combo box). To use the CE Keyboard, select Programs > Tools > CeKeys from the Start menu.

To minimize the keyboard, click the keyboard icon that appears in the system tray.

To see how to map the Carlson Explorer keyboards, go to the section called Keyboard Mapping in this manual.
Rebooting the Carlson Explorer

To reboot your Carlson Explorer, whether be a "soft reboot" or "hard reboot", follow the steps below.

Soft Reboot

To soft reboot, press and hold down the On/Off button for 10 seconds.

Hard Reboot

A hard reboot may be necessary due to these conditions:

- Bluetooth stops communicating correctly
- No communication can be established across the COM port
- The screen gets out of adjustment (too big, too small, is fuzzy)
- The ActiveSync connection gets dropped frequently, preventing the installation of Carlson SurvCE
- Unable to install or uninstall programs
- Incorrect amount of free memory being displayed for device

To hard reboot the Carlson Explorer, follow the below steps in this order:
1. Save your job file.
2. Close Carlson SurvCE, if possible, in order to safely remove the battery.
3. Remove the battery for about 10 seconds.
4. Reinsert the battery and turn the unit on, and it will reboot.
5. If you remove the battery while Carlson SurvCE is open, you may loose any accumulated data.

Operating System

Your Carlson Explorer uses an operating system, or OS, called Windows CE, a version of Microsoft Windows adapted to the Carlson Explorer. From time to time, the OS may be improved.

Instructions for updating the OS can be found in this manual, or on our web site www.carlsonsw.com in our Carlson Software Knowledge Base (under Support).

To determine the current operating system number, go to START, then Run, and type in "version". Tap OK. You will see the version number and build date.
Windows CE.net Desktop

This section provides a brief overview of the functions that appear on Carlson Explorer desktop. For information on how to change desktop settings, refer to the unit's on-line help.

Note: Due to limitations and sizing constraints, some features and functions of the Windows CE .NET Professional operating system (such as Bluetooth and Windows Media Player) may not be available or not available on Carlson Explorer at time of this writing.

Desktop Functions

You can access the following applications, functions and data entry utilities from Carlson Explorer desktop.
The Taskbar

The taskbar at the bottom of Carlson Explorer desktop displays the Start menu button, buttons of currently running applications, the Status Area and the Show Desktop icon. You may need to select the [2ND] + [W] keys in order to view the taskbar.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recycle Bin</td>
<td>Use the Recycle Bin to restore deleted files or empty the bin to create more disk space.</td>
<td></td>
</tr>
<tr>
<td>My Computer</td>
<td>Use My Computer to navigate and view the folders and files stored on Carlson Explorer.</td>
<td></td>
</tr>
<tr>
<td>Inbox</td>
<td>Use the Inbox to send and receive e-mail by connecting to a POP3 or IMAP4 server.</td>
<td></td>
</tr>
<tr>
<td>My Documents</td>
<td>The default storage location for documents, graphics, and other files.</td>
<td></td>
</tr>
<tr>
<td>Microsoft WordPad</td>
<td>Use WordPad to create or edit text files that contain formatting or graphics.</td>
<td></td>
</tr>
<tr>
<td>Internet Explorer</td>
<td>Use Pocket Internet Explorer to view Web pages. You will need a modem or Ethernet card to connect to an Internet service provider (ISP) or network.</td>
<td></td>
</tr>
<tr>
<td>PC Link</td>
<td>Use PC Link to make an ActiveSync, Bluetooth or other type of connection to another device</td>
<td></td>
</tr>
</tbody>
</table>

Windows CE.net Desktop Taskbar

Tap the Start button to display the Start menu (see below for details). For each open application, a button appears on the taskbar. Simply tap the application’s button to activate it. The status area appears on the right, and, by default, displays small icons for the input panel, current time, power status and network connections. Tap a small icon to activate the related program.

Tapping the Show Desktop icon (far right) minimizes any active applications, and redisplayes the desktop. Tapping the Keyboard icon displays the Input Panel menu for data entry.

Power Status Icons

Carlson Explorer will display power status icons in the taskbar status area to indicate power use, charging status and low battery conditions.
When you tap Start, the Start menu appears.

Tap, for example, Programs.
By tapping one of the menu's icons or names you can:

- Open programs that do not appear on the desktop
- View a list of web sites added to your Favorites List
- View recently accessed documents and images
- Access the Control Panel (under Settings), establish connections, or configure the Taskbar and Start Menu
- View Help
- Start an application using the Run command
- Place the unit in Suspend mode

**Hot Keys**

The below keyboard "hot key" combinations are menu-dependant, in that most of these key combinations function specifically within the Carlson SurvCE menu that you are in. You will use the multifunctional modifier keys ALT, 1ST, 2ND and Shift to perform these functions.

Consult your Carlson SurvCE manual for the menu commands that correlate with the shortcut keystrokes listed below.

**ALT Keys**

ALT Esc will bring you to the Windows Desktop
ALT Backspace will replace the last character that you erased
ALT and a tap on the screen is the right mouse click
ALT A will take a shot and store it
ALT B will bring you to the Instrument setup screen
ALT C will bring you to the Configure Reading Screen
ALT D will allows you to plug in a manual reading
ALT E will allow you to set your elevation within the ELEVATION DIFFERENCE ROUTINE
ALT F will Freeze your points on the Map screen
ALT H will bring up the Help screen
ALT I will bring you to the inverse screen
ALT K will bring up the calculator
ALT L will allow you to select codes for linework
ALT M will bring up the Map Screen, but will not bring you back
ALT N will bring up the screen to select the next point number when running in Stake Out
ALT N will allow you to select your next station within Stakeout Line and Offset Stakeout Routines
ALT O will brings up the Offset Screen
ALT P will list Points
ALT R will take reading
ALT S will store the reading
ALT T will allow you to store a Trav point and give you the option to move now or later
ALT V will bring up the View/Edit Screen
ALT W will allow you to add JOB notes
ALT X will exit the current program to the main menu
ALT Y will allow you to switch from the Graph screen to the Text screen, but not back to Graph screen
ALT Z will allow you to zoom to a point.

1ST Key Functions

1ST and the decimal will create quotation marks ""
1ST and A,B,C, and D are used as arrow keys
1ST and E will create a less than sign >
1ST and F will bring you to the end of your line of text
1ST and G will create an Underscore _
1ST and H will create a greater than sign <
1ST and I will create an opening parentheses (
1ST and J will create and exclamation point !
1ST and K will create a semicolon ;
1ST and L will create a closing parentheses )
1ST and M will create an opening bracket [
1ST and N will create a question mark ?
1ST and O will create an prime symbol ‘
1ST and P will create a closing bracket ]
1ST and Q will create an ampersand &
1ST and R will create an @
1ST and S will create an apostrophe ‘
1ST and T will create a dollar sign $
1ST and U will create a minus sign -
1ST and V will create a slash /
1ST and W will create an equal sign =
1ST and X will create a plus sign +
1ST and Y will create a percent sign %
1ST and Z will create an asterisk *
2ND Key Functions

2nd and 1 is F1
2nd and 2 is F2
2nd and 3 is F3, which will bring you to the Road Menu in the Main Menu screen
2nd and 4 is F4, which will bring you to the Surv Menu in the Main Menu screen
2nd and 5 is F5
2nd and 6 is F6
2nd and 7 is F7
2nd and 8 is F8
2nd and 9 is F9
2nd and 0 is F10
2nd and A will delete highlighted text
2nd and B will allow you to zoom out of your map screen
2nd and C will allow you to zoom into your map screen
2nd and E is for Caps Lock
2nd and F will bring you to the beginning of you line of text
2nd and I will create an opening, curly bracket
2nd and J will create a tilde
2nd and L will create a closing, curly bracket
2nd and M will allow you to tab left to another field for text
2nd and N will allow you to create a circumflex ^
2nd and O will colon
2nd and P will allow you to tab to your right to another field for text
2nd and Q will allow you to adjust the contrast of the screen down*
2nd and R will create a vertical bar —
2nd and S will create a number sign #
2nd and T will allow you to adjust the contrast of the screen up*
2nd and U will allow you to adjust the backlight down
2nd and V will create a comma ,
2nd and W will bring up the Windows Start Menu
2nd and X will allow you to adjust the backlight up
2nd and Y is F11
2nd and Z is F12

* Although noted on the keyboard, this is not an option with a color screen.

Shift Key Functions

The Shift key on the Carlson Explorer 600+ toggles whether or not you are operating with upper or lower case lettering.

Power

Hold down [On/Off] key for ten seconds, then power on. This is how to reboot.
For more information on this subject, see the Data Entry chapter in this manual.
Configuration 5
Control Panel

The table below lists the available Control Panel functions on the Carlson Explorer. Many of the items described in this table are covered in greater detail throughout this manual. To access the Control Panel, on your data collector screen tap Start > Setting > Control Panel, as shown in this figure.

![Control Panel Image]

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Aux Switch</td>
<td>For units with a second COM that supplies SYDC output, use this function to set the default power state (On or Off), and test the connected devices.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Backlight</td>
<td>Use this function to adjust the backlight setting for the following conditions: Line Active, Line Active Inactive, Battery Active and Battery Inactive.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Battery Select</td>
<td>Select one of the following options to calibrate the power status icon for proper use: NiMH, AC Line or Alkaline.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Beep Select</td>
<td>Use this function to change the frequency, volume and duration properties of the beep.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Bluetooth Device Properties</td>
<td>Use this function to scan for other Bluetooth devices and services in the area. For use by Bluetooth cards manufactured by companies other than Socket Communications, Inc. Socket cards use a different control. See Using Bluetooth for more information.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Certificates</td>
<td>Use this function to import, view or remove certificates, which protect your personal information on the Internet, and protect your computer from unsafe software.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>CPU Speed</td>
<td>For units with 400 MHz processors, use this function to determine the CPU speed (200 or 400 MHz) and mode (Turbo and Non-Turbo) during runtime and cold boot-up. Turbo Mode allows you to clock the processor core at a higher frequency during peak processing requirements.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Date/Time</td>
<td>Use this function to adjust the date, time and time zone.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Dialing</td>
<td>Use this function to adjust the dialing location settings and dialing patterns when using a modem.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Display</td>
<td>Use this function to adjust the backlight timeout, change the background image or change the desktop color scheme.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Display Rotation</td>
<td>Use this function to rotate the screen 180 degrees (upside down).</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Hot Keys</td>
<td>Use this function to assign functionality to the unit’s eight programmable keys (requires Keyboard Mapping).</td>
</tr>
</tbody>
</table>
### Setting the Date and Time

#### Using the System Tray

To change the date, time, time zone and related information on your Carlson Explorer, double-tap the time in your system tray at the lower-right of the screen. Make these changes via the system tray is the easiest and quickest way to perform this task.

If you cannot see your task bar, run your stylus along the bottom edge of the screen to have it pop up. If this does not work, press the BLUE key and the START key (blue 2ND key and the W key on the Carlson Explorer) on the key pad.

Set the date, time and time zone in the Date/Time Properties window.
Tap "Apply" to save the changes, and tap "OK" to exit.

**Using the Control Panel**

You can also make these changes within the Control Panel. To do this, tap Start > Settings > Control Panel > Date/Time. However, any time you make changes through the Control Panel (such as changing the time zone), you must also update the persistent registry, in order to store the changes in internal compact flash memory, and to make the changes permanent. See the Saving Changes to the Registry section of this manual for more information.

**Calibration of Screen**

For calibrating the touch screen, start by accessing the Start Button. If the Start button and Task bar are not visible, access the Start menu by pressing the [2ND] + [W] keys. Then go to the Control Panel.

Locate the Stylus icon. Double-tap the Stylus icon in the Control Panel to bring up the Stylus Properties.
Tap the Calibrate tab, and then tap "Recalibrate".

To calibrate the touch screen of your Carlson Explorer, follow the instructions on the screen. As you tap the crosses, be sure to touch the screen firmly with your stylus. Your screen will look like this:
When calibration is complete, you will see this message:

Press and briefly hold stylus on the center of the target.
Repeat as the target moves around the screen.
Press the Esc key to cancel.

When calibration is complete, you will see this message:

New calibration settings have been measured.
Tap the screen or press the Enter key
to accept the new settings.
Press the Esc key to keep the old settings.

Taskbar and Start Menu Settings

The taskbar at the bottom of the data collector desktop displays the Start button, buttons of currently running applications, the Status Area and the Show Desktop icon.

Windows CE.net Desktop Taskbar

To change the Taskbar and Start Menu settings:

1. Select **Start > Settings > Taskbar and Start Menu.** The Taskbar and Start Menu Properties dialog box opens.
2. Select the **General** tab.

   ![Taskbar and Start Menu Properties](image)

   **Always on Top**: Check Always on Top to ensure that the taskbar is always visible, even when a program appears in a full window (maximized).

   **Auto hide**: Check Auto hide to display the taskbar just when you point to the taskbar area.

   **Show Clock**: Check Show Clock to display the time of day in the taskbar.

3. Select the **Advanced** tab.

   ![Taskbar and Start Menu Properties](image)

   **Expand Control Panel**: Check the Expand Control Panel box to display the contents of the Control Panel as items on the Settings > Control Panel menu.

   **Clear**: Tap the Clear button to remove the contents of the documents menu.

4. Tap **OK** to save the settings and exit the menu.
5. From the Start menu, select Programs, then Tools, and then tap Save Registry.

Contrast and Backlight Settings

The Carlson Explorer you have received is pre-loaded with Carlson SurvCE, and the display settings are set to "High Contrast White". For calibrating the display light settings, go to your Control Panel and double-tap the Display icon.

To change the display settings:

1. From the WinCE desktop, Start > Settings > Control Panel > Display

2. In the Display Properties window, select the Appearance Tab. Note the scheme of High Contrast White. It is advisable to set your background to HIGH CONTRAST WHITE for a screen that will be easier to read in daylight.
3. Tap the Backlight tab. Change the settings to fit your Carlson Explorer usage by scrolling to your preferences.

Additionally, you may brighten the backlight settings as follows:
1. From the WinCE desktop, Start > Settings > Control Panel > Backlight.
2. Slide the backlight bar further to the right or left, as desired.

**CAUTION!** If your screen shakes in direct sunlight, you must go to **Start > Settings > Control Panel > VComAdj.** Inside this utility there is a slider bar.

While you are experiencing the shaking, move the slider SLIGHTLY left or right until the shaking stops. Moving the slider all the way to the left or right will most likely not resolve the problem.

**Network Connections**

You can connect your Carlson Explorer directly to a network through an Ethernet (provided that the CF Card is the same type) or dial-up connection to access e-mail, access files available on the network server, and browse the Internet.

**Creating a Network (Ethernet) Connection**

To create a network (Ethernet) connection:

1. On your device, insert the Ethernet card.

2. Select **Start > Settings > Control Panel.** Double-tap **Network and Dialup Connections.**

3. Double-tap the connection icon for the adapter. For example, if you have a NE2000 Ethernet adapter, double-click the NE2000 connection icon.

4. In the Ethernet Driver Settings dialog box, select **Obtain an IP address via DHCP,** and tap OK.

5. If prompted, enter the **User Name, Password,** and **Domain name** you use to log on to your network.

6. From the **Start menu,** select Programs > Tools and then tap **Save Registry.**

**Setting Up Identification for Remote Networks**
To set up identification for remote networks:

1. Select Start > Settings > Control Panel.

2. Double-tap Owner.

3. In the Network ID tab, enter the user name, password, and domain name you use to log on to the remote network.

4. From the Start menu, select Programs > Tools and tap Save Registry.

**Connecting to a Mail Server**

You can send and receive e-mail by connecting to a POP3 or IMAP4 server. Inbox contains an e-mail service for each method you use. For either service, you must establish a connection to your Internet service provider (ISP) or to the appropriate mail server in your local area network. In addition to creating this connection, you must also create the e-mail service.

Prior to setting up a service, you should obtain the following information from your ISP or network administrator: POP3 or IMAP4 server name, SMTP host name, user name, password and domain name (for network connections only).

**Notes:** Windows CE .Net does not support other mail protocols such as AOL or services that use special authentication, such as MSN. However, you can gain access to the Internet through these services. If you use the same service to connect to different mailboxes, set up and name a different service for each connection. For additional information about the inbox, refer to Windows CE .NET online help.

To connect to your POP3 or IMAP4 mail server:

1. Select Start > Programs > Inbox > Services > Options.
The Options dialog box opens.

2. Select the Services tab and tap Add. The Service Name dialog box opens.

3. From the Service type list, select POP3 Mail or IMAP4 Mail, and tap OK.
4. Enter a unique name for the service (you cannot change this name once entered).

5. Tap OK. The Mail Service Setup wizard appears.

6. In the Required panel:

Select the name of the connection you created to connect to the mail server. If you are receiving e-mail through a network (Ethernet) connection, select Network Connection.

If you want Inbox to use your current connection, select (none).

If you have not created a connection, select Create new connection, double-tap the Make New Connection icon, and follow the instructions in the wizard. When finished, select Inbox in the Taskbar and continue setting up Inbox.

Enter the POP3 Host or Server (IMAP4) name of the mail server you use to receive and send messages.

Enter the User ID (user name or mailbox ID) assigned to you.

Enter the password you will use to access this mail account. If you do not want a prompt to enter the password each time you connect, select Save password.

7. In the Optional panel:
If connecting to a network that uses Windows NT domain security, enter the Windows NT domain name.

If your mail service uses a separate server for SMTP, enter the SMTP Host name. For POP3 Mail service with an ISP, the ISP must use an SMTP mail gateway.

Enter your return e-mail address.

8. Tap Next. The General Preferences dialog box opens.

9. Choose any of the settings, all of which are optional, then click Next. The Inbox Preferences dialog box opens.
10. Choose any of the settings as needed, then click Finish. The Mail Service Setup wizard closes and the Options dialog box reappears.

**Note:** Receiving entire messages consumes storage memory.

11. Close the Options dialog box to return to the Inbox.

12. From the Start menu, select Programs and tap Save Registry.

**Additional Software**

**Software Programs for the Carlson Explorer**

The only programs that will run on your Carlson Explorer are those compatible with Windows CE. Look for programs that are compatible with the ARM-WINCE processor. You cannot run programs for Windows 95/98/ME/NT/2000/XP or some other Windows Mobile platforms. We have tested the Pocket PC and found that it is compatible with the Carlson Explorer.

**Installing Software (Other Than Carlson SurvCE)**

To install software other than Carlson SurvCE onto your Carlson Explorer, take these steps in this order:

1. Connect the Carlson Explorer to the desktop computer where the program that you want to install resides.
2. On your PC, double-click the Setup.exe or Install.exe to launch the installation wizard.
3. When prompted by ActiveSync© to "Use the default application install path?", answer "No". Then select "Disk" (System CF) from the dropdown list of available installation paths.
4. Perform a soft reset.

**Memory and Persistent Registry**

**Memory**
Your Carlson Explorer has two kinds of memory: RAM and the Compact Flash (CF) card.

RAM is volatile. If deprived of power, the contents of RAM are erased. This process is similar to what happens on your desktop computer when you restart it. The Carlson Explorer OS does not include a RAM backup utility. The compact flash card is non-volatile, and protects valuable data and software programs against loss. All files stored on your compact flash disk are located in the Disk folder (System CF). We recommend that all data and software programs be stored in this folder.

**CAUTION!** Note the File Structure of your Carlson Explorer.

**RAM and Memory allocation**

To look at the allocation of memory on your Carlson Explorer, go to the Control Panel, double-tap the System icon and then double-tap on the Memory tab. The Memory tab allows you to look at RAM memory segmentation between storage and programs.

![Memory allocation screenshot]

**Example:**

Memory use by OS: 10.2 MB  
Storage memory: 4.9 MB  
Program memory: 16.9 MB  
Total RAM: 32.0 MB
You may move the memory slider bar towards the left to allocate additional memory to programs. We recommend that you leave at least 500 KB of storage memory free for use by the operating system.

Deleting Persistent Registry

**CAUTION! If you delete the persistent registry, you will loose the Carlson SurvCE registration.** The software will be placed into a 30 point demo mode until the proper change key is re-entered, and a Save Reg is performed.

To reset the persistent registry:

1. From the On mode, press and hold the On/Off key for 10 seconds, similar to a hard reboot.

2. Before turning the unit back on, press and hold both the ESC button and the 2ND button down, while powering the unit back on.

3. When the loader runs, you should see "Invalidating Persistent Registry" displayed at the top of the screen, as shown below.

![Invalidating Persistent Registry](image)

Saving Your Registry

It is strongly advisable to save the registry in your Carlson Explorer data collector after upgrading your software.

Persistent Registry

The Carlson Explorer internal memory consists of DRAM and Flash. Typically, any changes made to the Carlson Explorer, including file creation, are temporarily stored in the unit's DRAM. You must then copy the files from DRAM to internal flash memory, or a removable compact flash card, to store the information permanently.

**CAUTION!** If you do not store the information to flash memory, and the unit loses power, all information stored in DRAM will be lost.

To keep this from happening, whenever you make changes that affect the registry, such and changing settings in the Control Panel or installing software, you can permanently store registry changes without writing to flash memory by using the Persistent Registry.
This task is easy to do on the Explorer. To store registry information on the Carlson Explorer permanently:

1. Exit to Windows.
2. Tap the START key on your task bar.
If you cannot see your task bar, run your stylus along the bottom edge of the screen to have it pop up. If this does not work, press the BLUE key and the START key (blue 2ND key and the W key on the Carlson Explorer) on the key pad.

3. Next, tap PROGRAMS.
4. Then, tap TOOLS. Now notice the item listed called SaveReg.

![Image of the taskbar and program list]

5. Tap SAVE REG on the Carlson Explorer. After you successfully save the registry, the message "Registry successfully saved" will appear. Tap OK to close the message box.

**Resetting the Registry**

To reset the Windows CE .NET registry back to the factory default settings:

1. Turn off the Carlson Explorer.

2. While holding the key in Column 1, Row 1 (upper leftmost) and the key in Column 1, Row 3, turn on the Carlson Explorer. For example:
3. If you are successful, the screen will display version information, followed by "Invalidating Persistent Registry," before it completes the boot up process.
Transferring Files
Using the Compact Flash Slot

Before You Start

Please note that the only folder that provides non-volatile (permanent) storage is the SystemCF folder. Information store in other folders will be lost when you remove the power from Carlson Explorer. You can, however, have Carlson Explorer automatically copy files from the SystemCF to other folders when booting up. See Launching Files at Startup for more information.

Using the Compact Flash Slot

Carlson Explorer’s equipped with a standard Compact Flash Slot access cover will allow you to access the slot to insert and remove Compact Flash and device cards.

If you intend to use a device card, it may also be necessary to install a driver. If so, make sure the card is Windows CE .net compatible and you have the necessary drivers. If you are not sure, check with the card manufacturer before attempting to install the card.

To transfer files using the compact flash slot:

1. With the front of the display facing you, push the compact flash slot cover (located on top of the unit) to the left.

The slot cover will automatically pop open.

2. Insert the compact flash/device card into the slot with the front of the display facing you, and the top of the card pointed to the slot, until it clicks and the release lever moves upward.
3. Close the cover.

4. When inserting memory cards, a "UserCF" folder will appear when you open My Computer. You can then copy and paste the contents of UserCF to the other folders on Carlson Explorer.

When inserting device cards, Carlson Explorer will attempt to recognize the device. If it finds a driver for the device, Carlson Explorer will display a dialog box for that device. For example:

![PROXIM Ethernet Driver Settings dialog box](image)

If the Carlson Explorer cannot find a driver for the device, it will display the following dialog box:

![Unidentified PC Card Adapter dialog box](image)
5. If the correct card type appears, you can enter the appropriate information in the dialog box as required, and then tap OK to complete the installation.

To remove a card from a slot, simply push the card release lever down and remove the card.

**Data/File Transfer**

**ActiveSync© and Other Programs**

The preloaded software on your Carlson Explorer may support data transfer between the Carlson Explorer and other platforms. If no data transfer software is supplied with the software you are using, then you can use Microsoft©ActiveSync©.

The PC-side version is available at www.microsoft.com/mobile/pocketpc/downloads.

For further instruction on connecting your Carlson Explorer to your PC using ActiveSync©, refer to the Carlson Software online Knowledge Base. Go there by going to www.carlsonsw.com/support.html, select Carlson Software Knowledge Base, and then choose Carlson SurvCE.

For instruction on connecting via other applications, refer to your software user guides.

**Job Storage**

**Storing Job Files in the Carlson Explorer**

All job files must be stored to the internal CF card ("hard drive") named system CF. In the event of a power loss or necessary hard reboot, this card will preserve these files.
Job files stored in all other on board locations, including the desktop, are vulnerable to deletion in the event of a power loss. The external CF card is not affected by this issue, and data may also be safely stored on it.

**Updating SurvCE Using ActiveSync**

Periodically, you will need to update your Carlson Explorer with the lastest version of Carlson SurvCE.

**Microsoft ActiveSync and PC Link**

Microsoft ActiveSync is necessary to update Carlson SurvCE. If ActiveSync is not currently on your PC, you must install it. To install ActiveSync on your desktop computer, visit www.microsoft.com and search for ActiveSync. You may also go directly to the download at:


Now, in order to connect and sync your Carlson Explorer to your desktop computer, the Carlson Explorer requires PC Link to be running while ActiveSync searches for the mobile device. Find the PC Link icon on the Carlson Explorer desktop.
When using ActiveSync, you need to make sure that you are using the proper cables to connect with your PC. These are the cables, or cradle, that came with your data collector. Once you are ready, here are the steps to follow:

1. Note which PC port you are connected through (i.e. 1, 2, 3, etc.).

2. Open up ActiveSync on your PC. In most cases it can be found in your taskbar as a small, gray, circular icon with two arrows running in a circle in the center.

3. Once you have opened ActiveSync, pull down the File menu. Open Connection Settings.

If you find that you cannot open Connection Settings, select Get Connected. You will be prompted to make sure that your collector is properly connected to the PC. Then select Next. You will be told that a connection could not
be made. You will then be allowed to access **Connection Settings**.

4. On this screen, shown above, you will be asked to set the port which you will be using to connect with the PC. Check the box above the port selection box marked for the serial cable. Then check **OK**.

5. You will now see an initial image indicating that your PC is about to connect to the data collector. Click **Next**.

You will then see an image of a computer sending information to a smaller computer.
While this is happening, go to your data collector and double tap the **PC Link** icon on the Carlson Explorer Windows CE desktop. This will open a window with a message telling you that it is connecting to the PC.

You may need to tap the **PC Link** icon on your collector a few times until a small computer appears and stays on the taskbar.
The ActiveSync icon on the PC taskbar will also turn green and make a connection sound.

6. Your PC will now prompt you to create a partnership. Select the No button and click Next.

![New Partnership](image)

You will be told that you will be set up for as guest in order to connect.

**Installation and Setup of the SurvCE Upgrade**

7. Locate the update where you have it saved on your PC and double tap it, or download it from www.carlsonsw.com and "run" it.

8. You have now entered the SurvCE Setup program.
9. Enter the name of the collector user, and the name of your company, if this information is requested.

10. You will now be asked if you want to overwrite your existing Carlson Software.

Click **Yes** to proceed with the re-install or upgrade.

11. You will then be asked if you want the update to be saved in the default directory.

Click **Yes**.
12. Once the download is complete from the PC, check your mobile device to see what steps are necessary to complete the installation.

13. On the collector, tap **OK** the screen to copy the files to the system.

14. Finally, click **Finish** on the dialog box on the PC (as shown in figure above).

Then click **Finish** on the dialog box on the PC (as shown in figure above).

14. Finally, click the Carlson Explorer SurvCE icon on your Carlson Explorer to run the application with the newly installed software update.

Should you have difficulties updating your Carlson Explorer, try warm-booting your data collector. To do this, go to the **Start** menu, **Programs**, **Tools**, and then tap **Warm Boot**.
Disabling Partnerships in ActiveSync

For Connecting Mobile Devices as "Guest"

The following describes how to disable partnerships in Microsoft ActiveSync, so that a mobile device will always connect to your computer as "Guest".

1. Choose "Run..." from the start menu.

2. Type "regedit" and press "OK".

3. Navigate the tree structure on the left side of window to "HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows CE Services.

4. From the "Edit" menu select "New" > "DWORD value".

5. Name the new DWORD "Guest Only".

6. Right click on the "Guest Only" DWORD and choose "MODIFY".

7. Change the "Value Data" field to "1".

8. Close the Registry Editor by clicking the "X" in the upper right corner of the window.

Using Bluetooth ActiveSync

Steps to Take

Here is a general set of instructions for getting Bluetooth ActiveSync working.
CAUTION! This isn't a perfect set of thoroughly tested instructions. This is simply a general set of ten steps to follow that should point you in the right direction. Any further support at this time from Carlson Software is not available concerning the issue of Bluetooth ActiveSync connections. Please understand that we are providing assistance with Microsoft ActiveSync, www.Socketcom.com Bluetooth CF Card and a third party or a Socket Bluetooth adapter on the desktop PC. Carlson Software does not manufacture the hardware, nor write the software, for any of these three items. Therefore, it becomes extremely difficult to try and provide further support for a connection using all three.

1. Make sure you are using ActiveSync version 3.8 or later.

2. Hook up the data collector to ActiveSync with the Serial Cable at least one time FIRST.

3. Get into the Bluetooth Configuration on the desktop computer, and setup a "Virtual Serial Port", so that the Bluetooth can utilize a specific COM Port Number (i.e. - COM 5).

4. In the Bluetooth configuration on the desktop, set the computer to be "Discoverable" by other devices.

5. Set the Connection Settings in Microsoft ActiveSync on the desktop computer to the "Virtual Serial Port", established in step 3 (i.e. - Com 5), and make sure that the box is checked to say "Allow Serial Connection..."

6. On the data collector, tap on the Blue B, down by the System Clock, and tap on Bluetooth ActiveSync.

7. It will search for the desktop. You have to check the box to say "Save for future use", and tap the desktop ID that pulls up in the list. (If it doesn't show up in the list on the data collector, your computer isn't set to discoverable). Then tap on Select to "select the desktop ID name".

8. You will be prompted for a Bluetooth Passkey on your desktop computer. Enter any four digits and click OK.

9. When the Data Collector asks you for a passkey, enter the same four digits and tap Reply.

10. ActiveSync should activate, and the green circle should start to spin as it establishes a Bluetooth connection to the data collector. Once it connects, you are all set. It will stay connected until you turn off the Data Collector or turn off the Computer. To revert the ActiveSync back to a cable connection, simply change the COM Port in the Desktop settings from the Bluetooth Assigned COM number back to COM 1.

CAUTION! When you are finished using ActiveSync, you need to properly close the Bluetooth Connection each time or your data collector may not work properly with GPS or Total Station equipment through Bluetooth. MAKE SURE to double tap the little icon down by the Clock on the data collector in the bottom-right corner – just to the left of the blue B. It should pop open a window that says "Hide & Disconnect". TAP ONCE on Disconnect. Now, after 5 or 10 seconds, the ActiveSync icon on the computer should change from green to gray. You have safely disconnected your bluetooth connection, and you can now power off your data collector.

Note: To revert the ActiveSync back to a cable connection, simply change the Com Port in ActiveSync. On
the PC desktop, open ActiveSync. Go File > Connection Settings. Then, set the Bluetooth-assigned Com number back to Com1.

Re-connecting in the Future

To activate the Bluetooth connection with ActiveSync in the future, on the data collector just tap the Bluetooth B (down by the clock) and tap Bluetooth ActiveSync. Then tap the Select button.

Updating the Loader and Operating System

Procedures for the Carlson Explorer/Carlson Jett CE

Below you will find instructions for updating your LOADER and OPERATING SYSTEM (OS) to the current version. You can get the newest OS at www.carlsonsw.com, under Carlson SurvCE, in the Knowledge Base. The Knowledge Base is found under Support on the website. It is recommended that you upgrade the loader and OS together as to insure compatibility.

Loader Upgrade

1. Power off the Carlson Explorer and remove any existing CF cards from the unit's card slot.
2. Insert the loader card into the CF slot, and then REBOOT the Carlson Explorer by holding down the power button for ten seconds, then release it. Press it once more and let off. The screen should display:

   UPDATE LDR912–REMOVE CARD AND REBOOT

3. Remove the loader card from the CF slot.
4. Power off the Carlson Explorer by holding the power switch down for ten seconds. Note: Let go of the power button when you see the screen start to fade out to gray. Do not warm boot or remove power.
5. Power the Carlson Explorer back on.
6. Delete these files from your flashcard before doing the OS upgrade. (You will not need these three files for anything else as they were only necessary for the Loader Upgrade).
   • LDR912.IMG
   • PJETV202.BIN
   • XXX2TXXX.44M

Updating your OS

1. Make sure you are plugged in to the AC wall adapter during these processes.
2. Extract the following Carlson Explorer loader upgrade files that you received (see above) to a local directory on your desktop computer, and then copy these files to a compact flash card (loader card).
   • LDR912.IMG
   • PJETV912.BIN
OS Upgrade

1. Insert the loader card into the CF slot.
2. Open My Computer. On the Main menu bar, select Options from the View menu, and uncheck the Advanced Setting boxes by tapping on each of them.

3. Navigate to the UserCF folder, double-tap NKUNLOCK.EXE and then copy NK.GZ.
4. Go back to My Computer, and navigate to the System CF folder.
5. In the System CF folder: Delete InitialFileList.txt and NK.BIN
6. Paste NK.GZ into the SystemCF folder.
7. Remove the loader card from the CF slot.
8. REBOOT the Carlson Explorer by holding down the power button for 10 seconds, and then release it press it once more and let off.
9. Tap Start. Tap Run. Then type in "version" and click OK. Check to see that your OS version has been updated.
Mapping the Keyboard
How to Map the Carlson Explorer Keyboard

In the event that your Carlson Explorer keyboard is not mapped correctly (you press a key expecting one character and instead see a different character printed) you should update your Carlson SurvCE software. If you are currently running the latest update, saving the same version over your existing one will have no adverse effect, but it will map your keyboard properly.

If you are running an Carlson Explorer (the "ESC" key is in the upper left hand corner of the keypad), then you must load SurvCE_Carlson Explorer.EXE.

If you are running a Jett (the "A" key is in the upper left hand corner of the keypad), then you must load SurvCE_Jett.EXE.

After re-loading, do a Save Reg. Do do this, go to Start, then Programs, then Tools, and choose SaveReg.

Once you have completed your reinstallation and the Save Reg of the software, you must reboot your collector within the Carlson SurvCE program. Open Carlson SurvCE and then hold down the power button for ten seconds. You will see that the screen fades away to black. When the ten seconds have gone by, you can turn your collector back on. This will successfully re-map your keyboard.
Caring For Your Carlson Explorer
Maintenance
The following procedures are routine maintenance tasks that need to be periodically addressed and performed.

Changing the NiMH Battery

Follow these below five steps to change the NiMH battery.

1. Before changing the battery, close all applications and save data to the System CF.
2. Changing batteries has no effect on programs and data on the flash Card.
3. Twist the flip-up ring, in the back of the Carlson Explorer, and open the battery door.
4. Using the battery strap, remove the battery from the battery compartment.
5. To insert the battery again into the battery compartment, just follow the instructions on the battery. You can see the "TOP" and "BOTTOM" indicators on the battery.

Cleaning the Case

Clean with a soft cloth dampened with either water or diluted mild detergent. If the keyboard has dirt or grime on it, use compressed air or vacuum cleaner, or gently rinse with clean water. CAUTION! Do not put the Carlson Explorer in the dishwasher.

Care of the Touch Screen

Abrasives are the enemy of touch screens. Keep the touch screen clean by using a soft cloth dampened either with
clean water or glass cleaner. Do not apply any cleaner directly to the display. Apply the cleaner to the cloth and then gently wipe the display. Do not use any abrasive cleaners.

**Applying Screen Protectors**

To apply a screen protector, follow these steps.

1. Clean the display thoroughly by adding a little water to the screen. Do this by adding water to a cloth and then wipe the screen gently.
2. Peel the backing from the screen protector before applying to the touch screen.
3. Use a credit card to squeegee the excess water and air from underneath the screen protector.
4. Then apply the screen protector per the instructions of the manufacturer of the screen protector.

**Safe Use of Your Carlson Explorer**

**Repairs**

Please do not attempt to dismantle your Carlson Explorer for repair. There are no user-serviceable parts inside. For service, please contact Carlson Software or your local dealer for assistance. Opening the Carlson Explorer for any reason will void the warranty. Keep in mind the following factors in order to use your battery and your AC adaptor safely:

**Battery Safety**

- To reduce the risk of fire or burns, do not disassemble, mutilate, or puncture battery pack. There are no user-serviceable parts inside.
- Handle damaged or a leaking battery with extreme care. If your skin comes in contact with the electrolyte, wash the exposed area with soap and water. If it contacts the eye, flush the eye with water for 15 minutes and seek medical attention.
- Do not expose the battery pack to high storage temperatures above 60°C (140°F) for extended periods.
- Do not charge the battery pack if the ambient temperature exceeds 40°C (104°F) or is below 0°C (32°F).
- Contact your local waste disposal provider regarding the disposal or recycling of the battery pack.

**AC Adaptor Safety**

- Use only AC adaptors intended for Carlson Explorer. Using any other AC adaptor may damage your product and may void your warranty.
- AC adaptors are designed for indoor use only. Avoid using the AC adaptor in wet outdoor areas.
- Unplug the AC adaptor from power when not in use.
- Do not short the output connector.

**Power Cords**
The AC adaptor requires an input power cord. The cord needs to match the plug and voltage requirements for your local area. If it does not, or if you are traveling to another country, please contact your dealer for the appropriate power cord.
Troubleshooting
Troubleshooting

Problem: My Carlson Explorer does not respond when I press the power button.
Solution: Is the unit in Suspend mode? If it is battery-powered, then check the batteries. Is the power supply plugged into an active AC outlet? Is the power connector securely plugged into the Carlson Explorer?

Problem: I changed my system settings, but when I turn on the Carlson Explorer my settings are gone.
Solution: You must save the registry after making any system or configuration changes. Do this by pressing Start > Programs > Tools > SaveReg.

Problem: I transferred files to the Carlson Explorer from my host computer, but when I turn on the Carlson Explorer my transferred files are missing.
Solution: To store transferred files permanently, you must file copy the files into internal flash memory (system CF) or compact flash card. Occasionally, transferred files can be hidden from view, double-tap My Computer, select Options from the View menu, and then clear all boxes.

Problem: I cannot connect to the development system using ActiveSync.
Solutions: Did you install the latest version of ActiveSync using the Administrator account? Also:

- Check the cable connections.
- Check the serial communications configuration.
- Make sure the correct COM port is available.
- In ActiveSync, check the Connection Settings for the connection type you are using (USB, Serial or Ethernet).

Problem: The screen is too light or too dark.
Solution: Adjust the Brightness via the brightness control in the Control Panel, or by using the shortcut key's U, X.

Problem: The Stylus is not responding properly.
Solution: The screen is not calibrated correctly to interpret the screen taps. You need to recalibrate the screen.

Problem: The Carlson Explorer acts slowly.
Solutions: The Unit may be short of program memory or storage memory. Increase the amount of storage or program memory through the System control in Control Panel. You can also delete any unnecessary files.

Problem: The Carlson Explorer does not recognize a compact flash or device card.
Solution: The card is not installed or seated properly. Reinstall the card. There may be an unstable connection between the card and the Carlson Explorer. Remove the card, clean the edge connector with a soft dry cloth, and reinstall the card.

Problem: The Carlson Explorer goes into auto-suspend after a short period of inactivity.
Solution: As default, the device will auto-suspend after two minutes of inactivity while running on batteries, and after thirty minutes of inactivity when running on AC power. Adjust the power management properties via the Power control in the Control Panel. To get there, go to Start > Settings > Control Panel. And then tap Power.

Problem: No sound is heard when you tap the touch screen or press a Key.
Solution: Volume setting is low or turned off. Check the volume slider in the Volume & Sound properties dialog box in the Control Panel.

Problem: I get little or no sound from the Carlson Explorer.
Solution: Adjust the volume and sound properties via the Volume and Sound control in the Control Panel.
Hardware Specifications

Carlson Explorer

Power
Recharge/Line-Power: 11 to 18 VDC, 1.5A

Battery Type
Nickel metal Hydride Rechargeable (1500mAh, 7.2V or 6 AA alkaline) batteries

Display
Supertwist Nematic Liquid Crystal TFT with white LED backlight
Resolution: 320*240 pixels QVGA color
Touch Screen

Environmental
Operating Temperature: -20°C to +50°C
Storage Temperature: -20°C to +70°C
Charging temperature: -20°C to + 40°C
Humidity: 5-97% Non-condensing

CPU
Type: Intel PXA255 processor with XScale technology
Instruction Set Architecture: ARM v.5TE
Speed: 400 MHZ
Operating System: Windows CE.NET 4.2 Professional

Memory and Mass Storage
SDRAM: 64MB
Internal Compact Flash: 128MB standard in the Carlson Explorer (16MB reserved for OS)
Compact flash card slot

Interface
Serial Communication:
Carlson Explorer-connect system interface configured as COM1 for RS-232 communication
Power:
Standard: Input at 11 to 18 VDC via Carlson Explorer connect system interface for line-power or battery charging operations

User Input
Touch Screen
Key Pad: 45-Key membrane (9 rows x 5 columns) or 15-keys elastomeric
Feedback: Tactile and audible

Carlson Explorer II
Power
Recharge/Line-Power: 11 to 18 VDC, 1.5A
Battery Type: Nickel metal Hydride Rechargeable (1500mAh, 7.2V or 6 AA alkaline) batteries

Display
Supertwist Nematic Liquid Crystal TFT with white LED backlight
Resolution: 320×240 pixels QVGA color
Touch Screen

Environmental
Operating Temperature: -20°C to +50°C
Storage Temperature: -20°C to +70°C
Charging temperature: -20°C to + 40°C
Humidity: IP-65 - Withstands wind driven rain and Dust

CPU
Type: Intel PXA255 processor with XScale technology
Instruction Set Architecture: ARM v.5TE
Speed: 400 MHZ
Operating System: Windows CE.NET 4.2 Professional

Memory and Mass Storage
SDRAM: 64MB
Internal Compact Flash: 256MB standard in the Carlson Explorer (16MB reserved for OS)
Compact flash card slot

Interface
Serial Communication:
Carlson Explorer - connect system interface configured as COM1 for RS-232 communication
Power:
Standard: Input at 11 to 18 VDC via Carlson Explorer connect system interface for line-power or battery charging operations

User Input
Touch Screen
Key Pad: 45-keys elastomeric
Feedback: Tactile and audible

Carlson Explorer 600+

Power
Recharge/Line-Power: 11 to 18 VDC, 1.5A
Battery Type: Nickel metal Hydride Rechargeable (1400mAh, 7.2V or 6 AA alkaline) batteries

Display
Supertwist Nematic Liquid Crystal TFT with white LED backlight
Resolution: 320×240 pixels QVGA color
Touch Screen
Environmental
Operating Temperature: -20° to +50° C
Storage Temperature: -20° to +70° C
Charging temperature: -20° to +40° C
Humidity: IP-65 - Withstands wind driven rain

CPU
Type: Intel PXA270 processor - designed specifically for low-power battery-powered devices
Instruction Set Architecture: XScale RISC micro architecture with on-the-fly voltage and frequency scaling,
sophisticated power management to provide industry leading MIP/mW performance.
Speed: 624 MHZ
Operating System: Windows CE.NET 4.2 Professional

Memory and Mass Storage
SDRAM: 128MB
Internal Compact Flash: 512MB standard in the Carlson Explorer (16MB reserved for OS)
Compact flash card slot

Interface
Serial Communication: Carlson Explorer - connect system interface configured as COM1 for RS-232 communica-
tion or USB
Power:
Standard: Input at 11 to 18 VDC via Carlson Explorer connect system interface for line-power or battery charging operations

User Input
Touch Screen
Key Pad: 53-keys elastomeric with toggle key
Feedback: Tactile and audible
Index

About Carlson Software, 9
About the Carlson Explorer, 9
Accessories & Options, 18
Additional Software, 50
Attention: Read This First, 2

Basic Information, 1
Bottom Connections, 15

Calibration of Screen, 39
Caring For Your Carlson Explorer, 73
Carlson Explorer Components, 12
Carlson Explorer Features, 9
Certifications, 5
Changes and Addendum, 3
Configuration, 36, 67
Connecting Via the Serial Port, 17
Contact Information, 3
Contrast and Backlight Settings, 43
Control Panel, 37, 39, 42–46, 51, 78, 79

Data/File Transfer, 58
Data Entry, 24, 35
Disabling Partnerships in ActiveSync, 66

Front Components and Indicators, 13

Hardware Specifications, 81
Hot Keys, 32
How to Map the Carlson Explorer Keyboard, 72

Job Storage, 58

Legal and Trademark Information, 3

Maintenance, 74
Mapping the Keyboard, 71
Memory and Persistent Registry, 50

Network Connections, 45

Operating System, 28, 81–83
Operation, 19
Overview, 8

Power, 20, 21, 23, 24, 30, 34, 68, 75, 78, 81–83
Product Returns, 5

Rebooting the Carlson Explorer, 28
Regulatory Notices, 5
repackaged, ii

Safe Use of Your Carlson Explorer, 75
Saving Your Registry, 52
Setting the Date and Time, 38
Specifications, 80

Taskbar and Start Menu Settings, 41
Top of Unit: Compact Flash Slot Cover, 14
Transferring Files, 55
Troubleshooting, 77, 78

Updating SurvCE Using ActiveSync, 59
Updating the Loader and Operating System, 68
Using Bluetooth ActiveSync, 66
Using the Compact Flash Slot, 56

Warnings, 6
Warranty Information, 4
What is in the Box?, 4
Windows CE.net Desktop, 29, 30, 41

Your Carlson Explorer, 2, 28, 51